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Introduction

StuckyNet-Link offers you 24-hour access to your current loan status, ledger, and ineligible
balances through a user-friendly web interface. Additionally the system enables you to
complete your borrowing base posting online and frees you from the costly burden of printing,
packaging, and shipping back up reports, saving you hundreds of dollars per month.

If you've used the Internet before, you will immediately feel comfortable navigating your way
through your loan information in StuckyNet-Link. All the familiar web elements are here, from
menus and hyperlinks to tables and forms. We want your experience with StuckyNet-Link to be
easy to use and understand.

Both novice and experienced Internet users can benefit from the information in this booklet.
Please read through it once to get an overview of what StuckyNet-Link has to offer and then
keep it for reference if you should need it at a later time.

Technical Information

Minimum System Requirements

e Microsoft Internet Explorer 6 or greater with 128-bit encryption
-Or- Netscape 7 or greater with 128-bit encryption

e 56Kbps modem or other high speed Internet connection
Internet Service Provider (i.e. MSN, AOL, Earthlink...)

Also Recommended

e Workstation access to electronic copies of supporting documentation
e Scanner for converting paper documents to an electronic format

e Microsoft Excel, Lotus Notes, or other spreadsheet software
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Logging In

Your collateral analyst will assign you a client code, username, and password. Enter these
codes in the corresponding fields on the login screen. Be aware that the password is case
sensitive.

Session Timeout

For security reasons, your session will end after 20 minutes if you are not actively using the
system. If your session ends you will be required to log in again.

Your session will also end if you close your browser window, switch to a different website
within the same browser window and then try to return using the Back button, and possibly
when you use the browser’s Refresh or Reload function. For these reasons it is
recommended that you use the system’s menu options to move through the website instead
of using your browser’'s Back, Forward, and Refresh buttons.

You are limited to five connections to the system at any one time. New connections can be
created if you close your browser without logging out of the system or have multiple browser
windows logged into the system at the same time.

If you receive a message stating that your user ID is being reported as already logged in,
wait ten or twenty minutes for a new session to become available or call your collateral
analyst to free up the connections.

Chanqging Your Password

You may be required to change your password both the first time you log in and on a
periodic basis. When required to change passwords you will be prompted to do so
immediately after logging into the system.

To change your password you must enter your current password, a new password, and the
same new password in the Confirm Password field.

New passwords are required to be at least five characters in length and contain at least one
alpha character (A-Z or a-z) and one numeric character (0-9).

Passwords are case sensitive.

If you forget your password please call your collateral analyst and it will be reset.
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Creating a New Borrowing Base Certificate

1. Click on Borrowing Base Posting from the menu.

2. Enter a certificate number in the ‘Certificate #' field under the heading ‘New Certificate’.
Borrowing Base Posting

Hew Certificate

Far Date: 11/03/05 E]

e The certificate number can be from one to six characters.

e The certificate number must be unique. If you duplicate a certificate number, you will be
prompted to enter a new number.

e The certificate number can only contain alphanumeric characters. Unacceptable
characters will be changed to a dash character (-).

¢ One recommended format for the certificate number is to use the date in the form of
mmddyy, e.g. use 112502 for Nov. 25", 2002.

3. Enter the date of the certificate, or use the calendar button J to select a date.
Entering an invalid date will cause the date to be recorded as the current date.

4. Click the ‘New Certificate’ button. A blank certificate will be displayed.

Loan # - Type 00 f AR (USC) 01 f AR (GERP)
Collateral Balance 21,000.00 12,868.00
Sales/tddtions |

Credit Memos

Cazh/Femovals

Discounts

|
|
Adjustmerts |
|
|
|

Mon-AFR Cazh

Mew Collateral Balance 21,000.00 12,865.00

e The text fields with a gray background are for your data entry.

e Text fields with a white background are calculated. If you type over a calculated field it
will revert back to its original value.

e The beginning balances on each certificate are pulled directly from the most recently
updated data and do not reflect any other saved or pending borrowing base certificates.

e Usethe Tab key to move between text fields. If you hit the Enter key instead of Tab,
your borrowing base posting may be submitted accidentally. If you submit the posting

before you are finished, just open the borrowing base again in edit mode (see next
section).
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Enter your posting information then click Save to submit the certificate when you are
finished.

After saving, the certificate will be displayed in a non-editable, printable format with the data
you've entered in a bold font. You may print a copy for your records, or review the
certificate later as a saved, pending, or historical posting.
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Editing a Saved Certificate

Your borrowing base posting is stored as a saved certificate from the time it is first saved until
your lender’s next scheduled download. Once the lender downloads the certificate, it will be
considered pending and you will not be able to edit or delete it.

Saved Certificates

Cert# 110305 11/0305

1. Click on Borrowing Base Posting from the menu.
2. Click the Edit button, or click the hyperlink for the certificate you want to edit.

3. The certificate will be displayed with your original data in the editable fields. Change the
information you need to, then click the Save button to resubmit the certificate when you are
finished.

4. Beginning balances and rates will be set to their current values, which may be different from
the values of the original posting.

5. If you make a mistake while editing a saved posting, you can use the Reset button to return
the values to their original state.

Deleting a Saved Certificate

Saved Certificates

Cert# 110305 11/0305

1. Click on Borrowing Base Posting from the menu.

2. Click the Delete button next to the certificate you want to delete. The certificate you want to
delete will be displayed.

3. Click Delete again to confirm the deletion of the certificate.

4. A message will prompt you that the posting has been deleted.
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Pending Status of Certificates

A borrowing base certificate is held in a pending state from the time the collateral analyst
downloads the posting until it is accepted into the system.

e Pending postings are displayed on the loan ledger with a different color background and the
word Pending in the Coll# column.

Date Azsrg  Coll#

1103103 110303  Pending

¢ Pending postings show up in the borrowing base posting program with a View button next to
them. You may review a pending certificate but not edit, delete, or make changes.

Viewing a Pending Certificate

Pending Certificates

Certd. 110303 110305

1. Click on Borrowing Base Posting from the menu.

2. Click the View button next to the certificate you want to review.

e The certificate will be displayed in a non-editable format with the data entry fields formatted
in bold text.

e The beginning balances and rates on pending certificates are the same values they were
when the posting was submitted.

Reviewing Historical Certificates

Date: Certificate #
1110305 110305

1. Click on Borrowing Base History from the menu.
2. Select a From Date — To Date range.

3. Alist will be displayed of the certificates submitted within the date range. Each certificate is
displayed as a hyperlink.

4. Click the hyperlink for the posting you wish to review. The certificate will be displayed in a
non-editable format.
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Calculating Availability

¢ New Collateral Balance = Collateral Balance + Sales/Additions — Credit Memos +
Adjustments — Cash/Removals — Discounts + Non-AR Cash

e New Net Collateral = Lesser Of
1. (New Collateral Balance — Ineligibles) * Advance Rate — Reserves
2. Collateral Limit

e Total Collateral = Lesser Of
1. Sum of all New Net Collateral fields
2. Revolving Limit + Sum of non-revolving New Net Collateral fields
3. Total Line Limit

e Collections = Cash Removals

e New Loan Balance = Sum of Loan Balances — Collections + Advance Request

e New Availability = Total Collateral — New Loan Balance

The availability calculation may involve factors not listed here. If this formula does not
give you the same availability number as your borrowing base or loan status report,
contact your collateral analyst.
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Loan Status Report

Loan Status

Client:TDRD  Date: 1103705

Loan # Type |Curr. Rate Gross Collateral  |Ineligible Reserve Loan Limit et Collateral Loan Balance  Availability

TDOROOD | &R USD  |50.00% 21,000.00 | 2146533.32 0.00 7.,000,000.00 | 1,700 426 66) 16,200.00 | [1,716,626.66)
TORODT | &R ZBP |80.00% 12,868.00 9,742.00 0.00 1,000,000.00 2,500.80 10,980.00 [8,479.20)
(LSO Total: 42,754,586 | 2,163,003.31 0.00 | 10,000,00000 | 1,698 195.76) 3476295 | (1,730961.74)

The loan status report is an overview of all the loans in your account as of the last time the
system data was updated.

This report does not include any pending or saved borrowing base certificate information in its
calculations.

Loan Ledger Report

Displays the line-item ledger of activity for each loan in your account.

e This report often requires Landscape mode when printed.
Loan Ledger

Laan Mumber: 0o s
From Dats: wpis ()
Ta Date: mpys [

Show Report

1. Click Loan Ledger Report from the menu.

2. Select the Loan Number you want to view the ledger for.

3. Use the default dates to display a current report, or select new from/to dates.
4. Click Show Report to display the report in your browser.

Loan Ledger

Loan: TORDOD  Activity Dates: 9/0105 to 11/03/05

Type: AR Currency: USD
Date Azsnd (Coll# Sales Credits & Gross Collateral Advances Adjustments ket Cash Loan Balance
Adjustments  Collections Balance

Beginning Balances -——-——-——-——mme— - = 14 600.00 5. 400.00
0105 0912a  |SM12 1,000.00 0.00 .00 15,600.00 0.00 0.00 0.00 5,400.00
90105 0912 |SM12 400.00 0.00 .00 16,000.00 0.00 0.00 0.00 5,400.00
S01/05 (0915 Sh-15 1,000.00 0.00 0.0a 17 ,000.00 500.00 0.00 0.00 5,900.00
S5 (09154 |SM-15 400.00 0.00 0.00 17 ,400.00 300.00 0.00 0.00 6,200.00
gm10s5 (091805 | SM-14 2,000.00 0.00 0.0 19,400.00 0.ao 0.00 0.0 5,200.00
105 (092005 |(SM-14 400.00 0.00 0.0 139,500.00 0.ao 0.00 0.0 520000
gm1ms (10003 (SM-15 0.ao 0.00 0.0 19,500.00 10,000.00 0.00 0.0 1620000
qm1mos |20 SR-05 100.00 0.00 0.0 19,900.00 0.ao 0.00 0.0 1620000
am1/0s (202 Sh-03 100.00 0.00 .00 20,000.00 0.00 0.00 0.00 16,200.00
am1m0s (205 Shl-12 1,000.00 0.00 .00 21,000.00 0.00 0.00 0.00 16,200.00
11/03/05 110305 Pending 100.00 177.00 0.0a 21,277.00 0.00 0.00 0.0a 16,200.00
Totals: §,500.00 A77.00 0.00 21,277.00 10,500.00 0.00 000 16,200.00

N —
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Ineligible History

Displays the ineligibles and reserves for each loan in your account.

Ineligible History

Loan Mumber: o0+

From Date: wotjs | [

To Date: noses [
Show Report

1. Click Ineligible History from the menu.
2. Select the Loan Number you want to view the ineligibles for.
3. Use the default dates to display a current report, or select new from/to dates.

4. Click Show Report to display the report in your browser.

Ineligible History:

Loan: TORODD Activity Dates: 10/01/05 to 11/03/05
Type: &R Currency: USD
Date Cver S0 CROSS AGING CORNCERNTRATION CREDIT PAST Contra Foreign Government |Affiliates Cther Total
DANSICREDIT LIMIT - |RULE RULE DUE RULE
203105 2135 02250 .00 0.00 g510.52 .00 0.00 o.oo0 0.00 | 000 |2146 53332
Date Reserve #1 Reserve #2 Rezerve #3 Tatal
210305 0.00 0.00 .00 0.00

o The header columns for this report are based on the most recent ineligible/reserve postings
for your account. The column headers will match the latest ineligible/reserve figures posted,
but might not match older rows.
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Printing Reports

Each report includes a Print button Frint | in the top right corner of the report screen.
Use this button to send the current frame to the printer.
Depending on your browser type and printer model, some printed reports may cut off the

rightmost part of the screen. If you have a problem, set your printer orientation to landscape
mode before printing.

Saving Reports

Click Save As in your browser’s File menu to save the report to a file.

You can also Copy and Paste reports from your browser into other programs like Microsoft
Excel or Word.

Loan: SPTI11 Activity Dates: 971505 to 10/06/05

1. When the report you want is on screen, click your mouse on the upper left corner of the
report. Holding the mouse button down, drag to select the part of the report you want to
copy. Your selection will be highlighted when it is selected.

2. Click Edit -> Copy from your browser menu, or right click on your selection and click Copy
from the context menu.

3. Switch to the program or document you want to paste the data into.
4. Click on the point in the document where you want the data to be displayed.

5. Click Edit -> Paste from the program’s menu, or right click on the document and click Paste
in the context menu.
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for later use, reformat it the way you'd like to see it, print it from the new program, or use the
pasted data to do calculations.

A B (& D E F G H | J K

1 Date | Assn# | Coll# Sales A;T;:feﬁ‘s CuI(I;t:gtsiTJns C;;:Z?;:' Advances | Adjustments |Net Cash|Loan Balance
2 Beginning Balances ----csemeeeeen = §25,103,385 82 §3,866 599,55
3 | 030102 |Loan |Limit; $25,000,000.00

4 | 030102 |IntFre  |BOGOOT $0.00 $0.00 F0.00| §25 103 558582 §0.00) $12347.28 $0.00| §3.873 24683
5 | 03/04/02|4-Mar  |Sh-14 $808,785.02| (§34,135.05)| &7 908.00] $25 57162779 $30,000.00 F0.00 $0.00| §3 953 546,83
B | D3/05/02|30402  |SK-04 $1.106952.32| (§65877.44) £945.80| $26 91178287 $250,000.00 F0.00 $0.00] §4.208 24683
7 | 03/05/02|306 Sh-06 §48 365.52 §7 76382 $2000.00| §265 965 513.21]  $500,000.00 F0.00 $0.00| $4 708 24683
8 | 03/0702|7-Mar [Sh-14 $93,703.20 F15930.56) (521 196.79)| §27 101 ,743.76]  $500,000.00 $0.00 $0.00| $5503 24683
9 | D31 402|14-Mar | Sh-14 $60601.58|  (§6369.47)| §6.450.28| $27 14952559 §0.00 §0.00 $0.00| $5 503 246,83
10 Totals: $2.124 441.64] ($52690.55)| (§3.558.71)] $27 149525.59| §1,630,000.00| $12347.28 $0.00| $5503 24683
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Uploading Files

1. Click on Upload Files from the StuckyNet menu.

2. Click on the Browse button to the right of the type of file you will upload.
Daily

Invoice Register: \
Cash Register: I \ Browse. . |

Adjustment Register: I \ Browse. . |

Monthly \

AR Aging: I Browse. . |
AP Aging: I Browse... |
Financial Staterment: I Browse. . |

Upload | Clearl

3. Inthe Look in box, click on the drive or
folder containing the file.

Choose Fiie

Look irk | ‘= Stuckyﬂeyhs = @l gl

4. Highlight the file you want to upload and |3 Arag‘”g

click Open.

=] ARAgINGP tat

ARDebtor prn
=) Ardebtor t
=] ArdebtoraB t

5. The filename will appear in the field of
the file type. In the sample below, an _
AR Aging file will be uploaded to the Flenams: JoRAging1 21503 [ |

system. Files of type: |41l Files (%) =l Cancel |

7

Daily

Invaoice Register: I Browse.. |
Cash Register: I Browse... |
adjustrment Register: I Browse... |

Monthly

AR Aging: [EfstuckyRepons\ARAg |

AP Aging: I Browse... |
Financial Staterment: I Browse... |

Upload I Clearl
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6. Click the Upload button.

7. A status bar on screen will let you know that the files are being uploaded. Make sure to wait
while your files are uploaded. If you navigate to a different page or close your browser the
file upload will be cancelled.

8. Alist of all the files uploaded will be displayed after a successful file transfer.

Files uploaded successfully!

[ File [ File Marne [ Size [ Type
[a/r Aging [Ex\Stuck yReports\ARAging1 21503 txt [s ke [text/plain
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Upload History

Upload history shows the names of the supporting documents that you've uploaded using
StuckyNet-Link.

Upload History

From Date: 10/01/05 (]
TaDate: 11/03/05 []
Show Report

1. Click on Upload History on the StuckyNet menu.
2. Use the default dates to display a current report, or select new from/to dates.

3. Click Show Report to display the report in your browser.

Upload History

Daily Files:

Uploaded File Date
CHhDocuments and Settings\Theresa'Desktop WP Glogin b=t 110205 14:07.00
ChDocuments and Settings\Theresa'DesktopBEPost_GetPending. 110205 12:04:14
Monthly Files:

Uploaded Fils Diate
CHhDocuments and Settings\Theresa'Desktop WP Glogin b=t 10205 12:04:14
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Aqging File Specifications

Please provide the following information for the A/R Aging files:

Customer Information
Customer Number
Customer Name
Street Address

City

State

Zip Code
Telephone Number

NoaswdPE

Iltems 1 and 2 are required.

A/R Aging Information
Customer Number
Invoice Number
Invoice Date

Due Date
Transaction Type
P.O. #

Transaction Amount

NoasMwdPR

All items except Item 6 are required.
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How To Print A Report To A File In Accubooks

We will use the Aging Report as an example.
1. Click on A/R - Reports - A/R Aging Report.

% AccuBooks 2000 - Al & Ed Electronics

File Edit CRM Inventory B0 D/E | AR POS P TimeCard Papwll A/ Bank Job G/L Tools Window Help

$ Setup 3

K] = [
PO | ORDER | INWIOILE | & “l_ff Enter/Edit &/F Transactions & Payments Chel+T
A/R Recuring Tranzactions 3

Post A/R Transactions

Deposit Payments To Checkbook 3
w Frocess MSF/Bounced Check
Unapplied Creditz 3

Generate Finance Charges

Custamer Listing
Custamer Mailing Labels
Custamer Motes

Custamer Histary

ik
Custamer Statements
ASR Tranzaction Raports
Cash Receipts By Customer
Cash Receipts By Payment Method

Salesperson Listing
Salesperson Commission B epart

Br\CbSB-ESC

2. Inthe A/R Aging Report window, choose the third button on the Send Output To section to
print to a file.

3. Type in ARAging and the date of the aging report in MMDDYY format. (i.e.
ARAQging030502.txt).| Use txt as the extension for the filename. Click OK.

% A/R Aging Report

Ageasof | 03/05/72002 H

1.) Tranzactions will be aged as of
the above date.

2.) This report will only includs
tranzactions prior to and
inclucing the above date.

Report Style]
& Detailed

¥ include Customers with Zero Balances:
IV Include Invoices with Zero Balances
v Aoe Payments with Invoices

€ Summary

™ Inciude Sales Orders

Starting Of Rang

Endl Of Range
Primary Sort [ Customer I [ [Fr=r | [ [cest | s
Secondary Sort Mil

Ta purchase forms or get free samples
call Zland.com Forms at
BRI ORS
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How To Print a Report To File In BusinessWorks

We will use the Aging Report as an example.

1. Click on the Accounts Receivable button. Click on Reports = Aging Report.

By BusinessWorks - SAMPLE

Transactions  Statements Customers | Beports  Close  Transfer  Utilities

Help

Dietail Report

Open Invoice Report
Lazh Flow Repart
Sales Analysiz Reports 3
Fayment Analyziz B eport

Open Credit Report

General
Ledger

Order
Entry

nventory
Cantrol

Cugtomer Deposit Report
Credit Limit Beport
Delinguent Accounts Report
Tranzaction R egizters

Sales Tax Report

oy

System
anager

Crystal Report
Wyriter

Payrall Job Cq G/L Beconciliation Report
Flash Repart
Buziness Graphics
s
--_ﬁ Feport Groups
" Custom Reports

2. Click on the Print Device button.

& Aging Report

3. Click on File and type in a filename
(“ARAging.txt") then click OK to export the
report to a flat file.

Customer categary to include | Al j

Print dewvice. Filters..
Report device  Screen K S e
Memarize | Add to Group...
3
From I M to I M

X Include all sales reps

From |1_E to lﬁ

Type of report
Primary zart by

Aged by

@ Detal O Summary

Customer |D j

® Dusdate O Irvoice date

[ Include contact infarmation

Aging 'az of date |n/a E or [X Current

[EAMPLE OK | X gancel| 2tep |
= Device Selection
) Screen
) SEtim..
) Printer IHF' Lazerlet BO00 M PCL B on NPID 37272 J —
O Earmat..

Path

File narme

Ie: WStuckyR epaorts

IAHAging.txt

Browse... |

7 Cancel | 2 Help |
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How to Export Data from an Excel Worksheet

The flat file format is used to create text files that can be opened in most other programs. For
example, this format is required by mainframe programs and is often necessary for government
reporting.

1. Open the Excel Workbook that you want to save to a flat file.

2. Click on CTRL-A to select the entire worksheet.

3. Click Style on the Format menu, and then click to ~ 2¥emm [uoml L e |
clear all check boxes except Font. o
Murnber
. . —atmrmmert g %I
4. Click Modify. T K/
IV [ Eant Arial 10 Bd |
I™ Border Delete |
[~ Patterns Merge. .. |
I
5. Click the Font tab, and then click a non- FormatiCalE 2[x]
proportional font (for example, Courier New) from : :
. Mumber | Alignment Font: | Border | Patterns I Protectlonl
the Font IISt' Font: IF&nt skyle: IE_Lize:
Courier Mew Reqular 10
6 CIle OK WVice M Copperplate Gothic Ligl’d - [ -
' " Courier Italic 9
i Bold
The format style of your v_vorkbook is now changed T Sl o ;11 -
so that the column width is based on the number Underiine: Color:
of characters that can be placed in the column. [ore | [ omatic =]
ffects revie
7. Adjust the column widths to suit your preferences. |_Suketreion
r Superscript - LaBhCoeYyiz N
™ subscript
8. On the File menu, click Save As.
Thids is a TrueType Font, The same Font will be used on both vour printer
9. Inthe Save as type list, click Formatted Text e

(Space Delimited). ok | concel

10. Click Save.

Save in: ID StuckyReparts \ j = | @ > @ ~ Tools ~

History

My Docurnents

File name: Ianging03D302.prn j n Save I
Save as bype: IFormatted Text {Space delimited) (*.prn) j Cancel |
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How To Print To A File In Microsoft SBM

We will use the Receivables Report as an example.

1. Click on Reports > Sales = Print Receivables Trial Balance.

Il Microsoft Great Plains Small Business Manager,

File Edit Tools Setup Utilities Shortcuts  Windows  Help

S WS E .
) The 'World Onling, Ine
Sales Purchases Financial Payrall Reports Pasting Shartcuts
? m Print Receivables Trial Balance I
= Purchases 3
L] Financial 3
Compariy 3
L lifeenEs Madify Reparts

LA AR

2. Inthe Receivables Trial Balance Reports, click on the drop-down and choose Historical
Aged Trial Balance.

& Receivables Trial Balance Reports

& Cear | &b Rint |
Print List
demo Insert >> |
Femave |
_ o

3. Click the New button.

4. Type AR Aglng Report for 3| Receivables Trial Balance Report Options CEX
Option. —_— W _Sove | F S —poisl h_Pint |
W InDetai

W Histarical Aged Trial Balance
5. Click on the Destination button.

by Customer 10 -

Sort Documents
3/20/2002

Sort Customers:

Print/Age as of: Enter Date -

Select Transactions For Report Using: ® GL Posting Date £ Document Date

xchude:
[ CrevisEglancs ¥ Zerm Balanca ¥ Unposted Applisd Gredit Documsnts
¥ Fully Paid Do [¥ NoActivity
Fianges: Customer 1D ¥ | From m
Tor @
Fiestrictions:

Inzet 3>

| ———————
Remave d Destination
= ]
o
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(How To Print To A File In Microsoft SBM, cont.)

[~ Report Information

6. In the Destination section click on File.

MName:

Optian:

Historical 4ged Trial Balance
AR Aging Report

[ Ask Each Time

7. Click on the Brow

Destination

Report Destination

Type the filename “ARAging” followed by the
aging date in the format MMDDYY (i.e.
“ARAQgiNg030302”) and use the extension .prn.
Change the Save as type list to Tab Delimited
Files. Click Save.

9. Verify the File Name and File Format (Tab-
delimited). Click OK.

10. Click on the Print button.
\

& Receivables Trial Balance

I Save x>

~ Report Information File: Name:
Mame: Histarical Aged Trial Balance File Fomat -
Option: AR Aging @ Append ¢ Replace
[ Ask Each Time
ok Cancel
[~ Destination
[ Screen
[ Prirter
¥ File
File Mame: C:AStuckyReportshARAgIng032002.pm
File Formnat: Tab - delimited -
£ fppend [

Save to Export File |E‘E|

Savein | StuckyReports

[

B & &

D

My Recent
Documents

=

My Documents

MINComputer

=

£4)

My Netwoge™ File pame: [ARagingt32002.pm -
Places
2 as tupe:

Save
Cancel

Report Gpiions

DElete |§ Frint |

EIBX

Select Trangactions Far Repart Usi

ing @ GL Posting Date

>
| Option: |AF\ Aging Repart \% Historical Aged Trial B alance I InDetail
Sort Customers: by Custorner D - Sort Documents: by Document Mumber -
Print/Age as of: Erter Date ¥ | 342042002

€ Document Date

Exolude:
’]- Credit Balance

¥ ZeroBalance

¥ Unposted &pplied Credit Documents

Restictions:

¥ Fully Paid Documents ¥ Mo Activity
Ranges: Customer [D * | From; @
To: m

Inzert »> |

N estinatinn

Remove |

3
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We will use the Accounts Receivable Aging Report as an example.

1.

StuckyNet-Link

User Manual

How To Print A Report To A File In Peachtree

Click on Reports = Accounts

Receivable.

Choose Aged Receivables under Report

List.

Click on the EXCEL button.

isx Peachtree Accounting: Bellwether Gardon Supply

File Edit Maintain Tasks Analysis Options Hepsds Semvices “Window Help

Lt Select a Hepnlt

Elnse Glnup D&Tgle énnt

Dlw [E=E ES Erel
ezign  Styles  Copy  Ewcel gip

Make any necessary changes on the

Report Area: Repont List: m
& Accounts Receivable Aged Receivables )
Cash Receipts Joumnal
'Eﬁ Accounts Payable Customer Ledgers
é Payrall Customer List
[ = [ R F SR T Y

Aged Receivables window. Click OK.

Accept the default to “create a new
Microsoft Excel workbook” and click OK.

is=Peachtree Accounting: Bellwether Garden Supply

File Edit Maintain Tasks Analysiz  Options | Beports  Services  Window Help

Accounts F'ayab\e
Payrall..

General Ledger...
Financial Statements. ..

Inventany...
Jabs...
Account Recanciliation...

Feport Groups...
Feport Styles...
My Business...

Ciystal Report Designer...

Aged Receivables ]
Filter 1 Fields | Forts ]

Beport Order: [ Custamer |0

AR Aosount 10 [

™ Print Report in Summary Format Cancel

Date: [This Period =] From: itz a1 200

Apply

REEE

Help

Filter R ange:
Copy Report to Excel x| Filter Type From To
Customer D All
Fiie Optiory Customer Type Al
@ Create a new Microsoft Excel warkbook Cancel |
" #dd a new worksheet to an existing Microsoft Excel workbook Hel
Help |

Eiawse..

Peachtree will start the
automatic export of the
aging to an Excel
spreadsheet and start
Excel.

CrSelect a Flepoll

i ..l.--l-iF

B T P

=10l

E\usz Enpylng Aged Flecewables to Excel Help

Report Description:

00 [ rreereem——m

Copying Aged Receivables data

outgtanding inwoices sorted in the
appiopriate aging categories. Sel up
aging categories in Cushormer

D efaults.

; General Ledger Customear 5 ales History
[iE  Financial Statements Invoice Register
Iterms Sold to Customers
m L] Pict et Repart
' Job Reports Prospet List
. Quote Register
& Account Recondilistion S eles: Backorder Report
E Repart Groups Sales Jourmal
Sales Order Jounal
El Sales Order Redister LI
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(How To Print A Report To A File In Peachtree, cont.)

7. The Excel spreadsheet will be formatted similar to the one below.

EZ Microsoft Excel - Book1
|
= =] | 5 [a ¥ |

[Tinesten fonan w5

Customer

B
1

EARUBNI nped receivables 4 [ [
T

=0

. .
8. Click on CTRL-A to select the entire worksheet.

Click on Format = Style.

LT

d
I |
I |
I |
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(How To Print A Report To A File In Peachtree, cont.)

11. Click the Font tab and then change the font to Courier New and click OK.

Format Cells

Mumber I Alignrment Fonit | Border I Patterns I Protegkidh
Fonk: Fant style: Siga
Courisr Mew IReguIar 10
"F Copperplats Gathic Ligh = 3 -
k]
Courier Mew
: e =l
Underline: Colar:
INone j I Autamatic j
Ffect: re
I strikethrough
™ Superscript AaBhiCoTyiz
™ ' Subscript
This is a TrueType font. The same Font wil be used on bath your printer
and your screen.

Concel_|

12. In the menu click File & Save As.

EZ Microsoft Excel - Book1

J@ File Edt Wiew Insert Formak Toolks Data Window Help

| gpen.. cto B % B @< o0 o83
| co e B rulls==8 s
E Customer
Page Setup...
Customer
Print Ares 3
1 Chapwan-Murphy Law
[ print Preview
& prrt... ik 1 Chapman-Hurphy Law (
¥
¥

Coletan Realty

COLEMAN-01

B e

13. Type in the filename ARAging and then the aging date in the format MMDDYY (i.e.
“ARAQing030302"). In the Save as type list, click Formatted Text (Space Delimited). Click

Save.
Save As [ x|
Savein: ID StuckyReports /Ll & | o B - Tools =
Toname:  [ARAging030302.pm = o
Save as bype: IFormatted Text (Space delimited) (*.prr) ﬂ Cancel I
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How To Print A Report To A File In QuickBooks

We will use the Accounts Receivable Aging Report as an example.

1. Click on Reports. _ =
Navigators

ﬁ Company

EZ Customers

E Vendors

g Employees
Banking

2% Business Services

2. Inthe Report Finder window, choose Customers & Receivables. Select A/R Aging
Detail in the report list.

3. Click on the Modify Repgrt’button to change/add report options.

ii feport Finder | x|

Select a type of repart

ICustomers % Receivables j Theke repoits provide information about pour customers and what
thily owe your comparny.
["Select 3 ieport.

AR Aging Detail
er Balance Surmary Tupe Date Narne Terms  Due Date Balance
Custorner Balance Detail Currert
Open Invoices Invoice  11/25/2000 Cook, Brian  Net 572000 __ 435 30
Collections Report Total Current E 488 50
.ccounts Receivable Graph 130
Unbilled Costs by Job .
T ransaction List by Custamer Invioice 1170142000 1240142000 565
Customer Phone List Total 1 - 30 585
Custormer Cantact List " 30
Itern Price List Invoice ell Estates Net 30 08/31/2000 _ 990.00
Total » 30 % 990.00
TOTAL 148295
Set the date range. /
[Today Tl LA st gt o st s et g
From T, ‘what you'll leam

1271542003 @ 252003 E Wihich invoices or statement charges are due and overdue?

Muodify Report... | Digplay | Prirt. | Excel |

4. Make any necessary changes to the report format. Please refer to the A/R Detalil file layout
for required fields.

5. Click OK.

Modify Report: A/R Aging Detail

Displap I Filters I Header/Footer ] Fants & Mumbers I

Feport Date Range

Dates ~| Todayonly

Fiom [12716/2002 | To [12/15/2003 |

Report Bazis
& Accual " Cagh This setting determines haw this report calculates income and expenses.
Colurming
[+ [left rargin) ﬂ Sart by |Default ﬂ
Tranz #
-/ Type & Azcending order 4

A

z
Ertered/Last Modified Sotin o~ P ecoending arder 54
Last madified by 5

[ Date
MNum
PO #

L/ Hame Fut a check mark nest to each colurnn
Source Mame LI that you want to appear in the report.

Advanced.. | Revert |

0K Cancel | Help |
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(How To Print A Report To A File In QuickBooks, cont.)

6. Click on the Display button to preview the report.

TEjiReport Finder [X]
Select a type of repart.
|Eust0mer8 & Receivables w | These reports provide information about your customers and what
thiey owe pour company.
Select a report.

AR Aging Detail
Date Marne Terrns  Due Date Balance

A
ustamer Balance Summany
Customer Balance Detail
Open Invoices

Collections FRepart
Itcoounts Receivable Graph
Unbilled Casts by Jab
Transaction List by Customer
Customer Phone List
Customcr Contact List

M S/2000 _ 488.30

488,30

120172000 5.66

etell Efates Met 300\ 02/31/2000 _ 990.00

Item Price List Invoice
Total > 30 990.00
TOTAL 1,483.93
Set the date range.
[Today LIEPVVN P N
From To ‘what pou'll learn

|12#1 /2003 @ |12f15f2003 E ‘which invoices or statergpt charges are due and overdus?

Modify Repart...

Digplay Print... Excel...

7. Check the report and resize the columns as necessary. To change the size of a column,
point the cursor at the small diamond to the right of the column. Drag the small diamond to
the left or right to adjust the column width. In the example, the “Name” column needs to be
adjusted to show the full address.

[ElA/R Aging Detail
8. CI|Ck on the Print Iodify Report... Hide Header Refregh
button ) Dates |Toda}l ﬂ |1 2/15/2003 E Interval [days] W Through [days past due) W Sort By lﬁ
L Rock Castle Construction
1211503 A/R Aging Detail
Accrual Basis As of December 15, 2003
Type % Date S P. 0. # ES Hame + DueDate <+ OpenBalance -«

P Irvoice 11852003 Pretell Real Estate: 155 WY, 12M 52003 107250 4
Invvoice 121 5/2003 Robson, DarciRobson C... 12452003 1242098
Imvoice 1209/2003 Smallson, Fran: Office rem... 120242003 1,665.00
Invoice 1172552003 Cook, Brian:Kitchen 120252003 466 69
Invvoice 1112552003 Cook, Brian:2nd story ad... 120252003 500330
Imvoice 1112512003 Jacobzen, Doug: Kitchen 1202512003 224500
Invoice 1172552003 Burch, Jason:Room Addi.. 120252003 1,005.00
Irvvoice 112552003 Abercrombie, Kristy:Rem... 120252003 3111.28
Imvoice 12112003 Teschner, AntorcSun Ro... 120262003 1,225.00
Invvoice 1113052003 Ecker Designs:Office Re... 1203002003 146530
Irvvoice 11730/2003 Metton, Johnmy:Dentsl of... 1203002003 499950
Ireeoice 1240172003 Pretell Real Estate: 75 Sun... 12/31/2003 1241215
Invvoice 121052003 Pretell Real Estate: 133V, 01092004 1,715.00
Irvoice 121172003 Cook, Brian:Kitchen 01 M 002004 5495
Invvoice 121 5/2003 A905-01 Ecker Designs:Office Re...  01M 472004 475781
Invvoice 121552003 Baker, Chris:Family Room 01 M 42004 1,040000
Invoice 121552003 Cook, Brian:Kitchen 01 M 42004 1, B36.69
Ireeoice 12M5/2003 Pretell Real Estate: 75 Sun... 011 4/2004 1241218

_invoice 12M 552003 Ecker Designs: Office Re... 014402004 146530 i |
4 3
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(How To Print A Report To A File In QuickBooks, cont.)

9. Inthe Settings tab, choose File as the printer option. Accept the default setting of ASCII
text file.

Print Reports

Settings | Margins

Print to:
" Prifer: IHF' Lazerlet S000N PCLE on NPID3?2?2ﬂ

Print |
Cancel |
Help |

Mote: To install additional printers or to change porl .
azzignments, uze the Windows Control Panel. Preview |

Optiong...

ASCII tent file |

[Hrientation: Page Range:
& Fortrait £ Al
" Pages:
¥ [andscaps
= From: [T To[3959
Fage Breaks:

I7 | Smart page breaks (widow/orphan control] | Humber of copies: |1

I¥ | Page break after each major arovping

I= | Fit report to I‘I page(s| wids I Fritit iry eolar (colan pritters only]

10. Click Print.

11. Type in the filename ARAging and then the aging date in the format MMDDYY (i.e.
“ARAging030302"). In the Save as type list, accept the default Text(*.txt). Click Save.

Create Dizk File EE3

Save in; Ia StuckyReparts j ﬁl
Araging x

ARAGINGP Bt

J&RAging? 21503 bt

ag bype: ITe:-tt [.t=8]

Lires Per Page: ID Width: IE
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General Print-to-File Instructions

These instructions will help you set up a “Text-Only Printer”, which will allow you to print reports

to a text file.

1. Click Start =» Settings =

Printers. e

2. Double-click the icon for Add
Printer.

Add Printer Wizard

Click the manufacturer and rmadel of your printer. If your privker canme with an
ingtallation digk, click Hawve Digk. IF your printer iz not listed, consult your printer
documentation for 8 compatible printer.

3. Follow the “Add Printer Wizard”
instructions. Specify “Local Printer”
when prompted.

4. Select Generic and Text Only

M anufacturers: Printers:
W Generic / Text Orly
=
[ eztetner LI

Hawve Disk... |

printer. Click Next.

< Back I Mest > I

Cancel |

5. Select FILE when prompted for the port to
use with the printer. Click the Next
button.

6. Name the printer whatever you like. You
will probably not want to use this printer
as the default.

7. Print a test page when prompted. Each
time you print to this new “Text-Only
Printer”, you will be prompted for a
filename to print into. For this test, call the
file “TEST.PRN” and put it in the root of
your C: drive (C\TEST.PRN)

8. To check whether the page printed
properly, run Notepad and open the file
CATEST.PRN. You should see the text
from the “Add Printer Wizard” test.

9. If you were successful adding the Text-
Only Printer and creating the test file,
that’s all you need to do. Whenever you

need to create a report as a text file (so that you can send it electronically), just select your

Text-Only Printer and specify a file name.

Add Printer Wizard

Click the port you want to use with this printer, and then
click Mext.

Auwailable ports:

Communications Port
Communications Port

Lreates 3 file on disk
WWCOMPAGTSO0NHPE000M
WCOMPAGTE00NHPLASERJET 44
Unknawn lacal port

LConfigure Port. .

< Back I Mext » I

Cancel |

Add Printer Wizard

Y'ou can type a name for thiz printer, or you can use
the name supplied below. ‘When you have finished,
click Mext.

FPrinter name:

Generic / Text Only

Do you want your Windows-based programs to use this
printer as the default printer?

© Yes
& Mo

< Back I Mext > I

Cancel |

Page 29



	 
	 
	 
	StuckyNet-Link 
	User Interface Manual 
	 Contents 
	 Introduction 
	 Logging In 
	 
	 
	Session Timeout 
	Changing Your Password 
	 
	 Editing a Saved Certificate 
	Deleting a Saved Certificate 
	 
	 Pending Status of Certificates 
	Viewing a Pending Certificate 
	 
	 
	Reviewing Historical Certificates 
	 
	 Calculating Availability 
	 
	 Loan Status Report 
	  
	 
	The loan status report is an overview of all the loans in your account as of the last time the system data was updated.   
	Loan Ledger Report 
	 Ineligible History 
	 Printing Reports 

	Depending on your browser type and printer model, some printed reports may cut off the rightmost part of the screen.  If you have a problem, set your printer orientation to landscape mode before printing.   
	 
	 
	Saving Reports 
	 
	 Uploading Files 
	 
	 Upload History  
	 
	  
	 Aging File Specifications 
	Customer Information 
	A/R Aging Information 

	 
	 How To Print A Report To A File In Accubooks 
	 How To Print a Report To File In BusinessWorks 
	 How to Export Data from an Excel Worksheet 

	 How To Print A Report To A File In QuickBooks 
	 General Print-to-File Instructions 



